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END USER SOFTWARE LICENSE AGREEMENT 

FOR BIZCARDREADER 
 

IMPORTANT 
READ CAREFULLY THIS LICENSE AGREEMENT. BY INSTALLING, COPYING OR OTHERWISE USING THIS 
SOFTWARE, YOU ACCEPT ALL THE TERMS AND CONDITIONS OF THIS AGREEMENT. IF YOU DO NOT 
ACCEPT THE TERMS OF THIS AGREEMENT, DO NOT INSTALL, COPY, OR USE THE SOFTWARE 
 

DEFINITION 
"SOFTWARE" refers to the computer programs contained in this software package, and the programs contained in 
the EDT/Cardreader OCR Developer Toolkit (Version 10) libraries, but specifically excludes the programs contained 
in the BARCODE.DLL library. The term also includes all copies of any part of the computer programs. 
 

COPYRIGHT PROTECTION 
This SOFTWARE is owned by Cardreader, Inc. ("CRI") or its suppliers and is protected by United States and 
international copyright laws and international trade provisions. Therefore you must treat this SOFTWARE like any 
copyrighted material except that you may either (a) make one copy of the SOFTWARE solely for backup or archival 
purposes, or (b) transfer the SOFTWARE to a single hard-disk and retain the original solely for backup or archival 
purposes. You may not copy any written materials accompanying the SOFTWARE. 
 

OVERVIEW 
The SOFTWARE is licensed on a per copy per device basis. A hardware partition or blade is considered to be a 
separate device. 

 

LICENSE GRANT 
You may install and use one copy of the SOFTWARE on a single device. This is the “Licensed Device”. You may 
use only one copy of the SOFTWARE on the Licensed Device at a time. 
 
You may use more than one copy of the SOFTWARE on the Licensed Device at a time only if you acquire and 
dedicate a separate license for each copy of the SOFTWARE used concurrently on the Licensed Device. 
 

The primary user of the Licensed Device on which the SOFTWARE is installed may make one other copy of the 
Software and install it on a portable device for his or her exclusive use, provided that the copy of the Software on the 
portable device is not installed or used after the time such user is no longer the primary user of the Licensed Device 
on which the Software is installed. 

 
You may not rent or lease the SOFTWARE, but you may transfer the SOFTWARE and all accompanying written 
materials (including any serial number) on a permanent basis to another person or entity  provided that you retain no 
copies and the recipient agrees to the terms of this agreement. 
 
You may not reverse engineer, decompile, dissemble, or create derivative works from the SOFTWARE. 
 

UPGRADES 
If the SOFTWARE is an upgrade, you may use or transfer the SOFTWARE only in conjunction with the upgraded 
product, unless you destroy the upgraded product. Any transfer must include all prior versions of the SOFTWARE 
and documentation. 

 

TERMINATION 
This license will terminate automatically if you fail to comply with any of the terms or conditions of this Agreement. 
On termination, you must destroy all copies of the SOFTWARE and documentation. 
 

LIMITED WARRANTY 
CRI warrants that the SOFTWARE will perform substantially in accordance with the accompanying written materials 
for a period of 60 days from the date of receipt. 
 
If the SOFTWARE fails to comply with the warranty set forth above, CRI's entire liability and your exclusive remedy 
will be, at CRI's option, either (a) the refund of purchase price, or (b) the replacement of the SOFTWARE. Any 



 

replacement SOFTWARE will be warranted for the remainder of the original 60-day warranty period or for 30 days 
from the date you received the replacement, whichever is longer.  
 
THE ABOVE WARRANTIES ARE EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES, EXPRESSED OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS 
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. NO ORAL OR WRITTEN INFORMATION OR ADVICE 
GIVEN BY CRI, OR ITS EMPLOYEES, DISTRIBUTORS, AGENTS, OR DEALERS SHALL INCREASE THE SCOPE 
OF THE ABOVE WARRANTIES OR CREATE ANY NEW WARRANTIES. 
 
THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY HAVE OTHER LEGAL RIGHTS THAT 
MAY VARY FROM STATE TO STATE. 
 

LIMITATION OF LIABILITY 
CRI SHALL NOT BE LIABLE FOR ANY DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION TO, 
DAMAGES FOR LOSS OF PROFITS, BUSINESS INTERRUPTION, LOSS OF INFORMATION, OR OTHER 
PECUNIARY LOSS) ARISING OUT OF THE USE OR INABILITY TO USE THIS SOFTWARE. IN NO EVENT SHALL 
CRI'S LIABILITY FOR DAMAGES RELATED TO THE INSTALLATION OR USE OF THE SOFTWARE EXCEED THE 
AMOUNT YOU PAID FOR THE SOFTWARE. 
 
SOME JURISDICTIONS DO NOT ALLOW EXCLUDING OR LIMITING IMPLIED WARRANTIES OR LIMITING 
LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES, AND SOME JURISDICTIONS HAVE SPECIAL 
STATUTORY CONSUMER PROVISIONS WHICH MAY SUPERSEDE THIS LIMITATION. AS A RESULT, THIS 
LIMITATION OF LIABILITY MAY NOT APPLY TO YOU IF PROHIBITED BY THE LAWS OF YOUR JURISDICTION. 
 

US GOVERNMENT RESTRICTED RIGHTS 
The SOFTWARE and documentation are provided with restricted rights. Use, duplication or disclosure by the 
Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and 
Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer 
Software - Restricted Rights  at 48 CFR 52.227-19, as applicable. Manufacturer is CardReader, Inc., 1411 Ramon 
Dr., Sunnyvale CA 94087. 
 

GENERAL 
This agreement will be governed by the laws of the state of California. This Agreement is deemed entered into at 
Sunnyvale, California by both parties.   If any provision of this agreement is found to be unlawful, void, or 
unenforceable, then that provision shall be severed from this agreement and shall not affect the validity and 
enforceability of any of the remaining provisions. 
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General Information 

BizCardReader is an application that scans and manages your business cards by saving a picture of each 
card and automatically creating a database of your business contacts. Using Optical Character 
Recognition (OCR), a technology that allows computers to recognize printed text, BizCardReader will 
automatically read, sort and place card information into categories such as name, company and address 
in the database. BizCardReader also scans and stores photographs. 

System Requirements 

 Computer running Windows 8 / 7 / XP or higher 

 Minimum 16 MB RAM 

 Minimum 20 MB free hard disk space. 

 Available USB port with  0.5 A power (if card scanner is used) 

Installing the Card Scanner 

The BizCardReader CD is needed to install the drivers for the card scanner.  

 

You should logon to Windows as Administrator to ensure that you have sufficient privilege to install the 
scanner drivers. 

 

Installing the Scanner Driver  

 
1. Insert the BizCardReader CD into the CD ROM drive and follow the on-screen instructions to install 

the BizCardReader application. Leave the CD in the drive and continue with the next step. 
2. Plug the card scanner into the computer's USB port. 
3. The system new hardware wizard will indicate that a new scanner has been found. Press "Next" to 

continue. 

4. Select "Search for the best driver (recommended) ..." and click Next. If you have an internet 
connection, allow the system to search online for the latest available drivers. 

5. If prompted to specify a location for the scanner driver, select the CD ROM drive by checking the 
appropriate box.  

6. Continue the installation procedure to completion. 
 
 

Troubleshooting the Card Scanner 

(A) Improper driver installation 
If the scanner will not scan after you install the driver, you should try to re-install/update the driver. The 
following procedure describes how this can be done. 
1. Place the BizCardReader CD into the drive, and exit the application software installation if prompted.  
2. Unplug the USB cable from the scanner for a few seconds and then plug it back in. 
3. If the system new hardware wizard is displayed, then follow the steps described above to install the 

scanner driver. Otherwise go on to the next step. 
4. Start up the Windows Control Panel by clicking on the Windows task bar Start… Control Panel. 
5. In the Control Panel, select Performance/System and Maintenance and click on the System icon. 

Then select Device Manager (for Windows 2000/XP users click on Hardware, then Device 

Manager). 
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6. If you see the BizCardReader scanner device with an exclamation mark beside it, highlight it and click 
Properties/Update Driver. Follow the instructions to search/locate the driver on the CD ROM. Click 
Finish after the driver is installed. 

 

(B) CONFLICT WITH OTHER USB DEVICES 
Some problems are due to conflicts with other devices on the USB. To resolve this, disconnect all other 

devices (and/or hubs), and plug the card scanner directly into the USB port of the computer. If necessary, 
re-install the scanner driver. 
 

The DuplexScan 1200/1210 Series Card Scanners 

The DuplexScan 1200/1210 scanner is a double sided scanner which scans both sides of an input 
document in a single pass. The input document can be returned (ejected) either at the front or the rear of 
the scanner. The document eject mode is set from the software in the scanner settings and options. 
 

Inserting the document (card) for scanning 
The card should be inserted into the front of the scanner at the RIGHT end of the input slot. 
 

Optional External power adapter 
For high volume usage of more than 200 scans per hour, you can use an external power adapter to 
supplement the battery power. If this is needed, please contact CardReader, Inc. 
(www.bizcardreader.com) to purchase the power adapter. 
 

Built-in Rechargeable Battery 
The unit contains a built-in self-recharging battery which boosts the scanning performance of the system. 
When you use the scanner for the first time, you should plug it into the USB port of a live PC, and allow 
the battery to charge for about 2-4 hours. The battery should last for several years in normal usage, and 
can be easily replaced if needed. If the red low battery light remains on for extended periods, you may 
have to replace the battery. 
 

System Settings 

In BizCardReader there are several settings that affect how the system processes the cards. To view the 

default system settings, select the Settings menu item. Then select the System option. The System 
Setting dialog box appears. The following settings can be enabled / disabled by clicking on their respective 
checkboxes: 
 

 Read card contents (OCR) after scanning: If enabled, the system activates the OCR process to 
read the card contents after scanning. If disabled, OCR is not activated and only the scanned card 
image is displayed. 

  

 Automatically correct for upside-down cards: If enabled, the system automatically flips the 
image to the correct orientation even if it was scanned in upside down. 

  

  

 Prompt before overwriting database: If enabled, when the user wishes to save the database, 
BizCardReader prompts before overwriting the current contents of the database. 

  

 Enable balloon help: If enabled, the system will pop up the balloon help when the cursor is 
placed over an icon. 

  

  

http://www.bizcardreader.com/


 

 3 

 Use uppercase for field data: If enabled, the system changes the card contents to uppercase 
when writing into the data fields. 

 

To activate/de-activate an option, simply click on the corresponding checkbox to add/remove the check. 

To confirm the settings, click OK.  
 

The Maximum records per database parameter allows you to set the maximum number of records that 
can be accommodated in a single database.  
 

Scanner Settings 

To view and change scanner settings, select the Settings menu item. Then select the Scanner option. 
The Scanner Settings dialog box appears. The following options are available. 
 

 

Image Format 
This specifies the format to save the scanned card images.  The recommended format is JPEG Medium 
Compression. 
 

Scan Resolution 
The recommended setting for scanning business card and IDs is 300 dpi. 
 

Scan Brightness 
The recommended setting is NORMAL, and typically should not be changed. If you find that the scanned 
cards are consistently scanned in too dark, you can select the Lighter option. Similarly, select Darker if the 
cards are scanned in too light. 
 

Image Type 
Select the image type to store the images. The recommended image type is 24 bit color.  
 

Double Sided Card Images 
When scanning double sided cards, you can tile the front and back images of the card either vertically 
(one above the other), or horizontally (one beside the other). 
 

Automatically start scanning when card is placed on the card scanner 
Check this option if you want the system to automatically start scanning when a card, photo, or other 
document is placed on the scanner. If this is not enabled, you will have to manually click on the scan icon 
to activate a scan. 
 

Select... 
Click this button to select a scanner. A Select Scanner dialog box appears showing the list of available 
scanners. Select a scanner from the list and click the OK button. 
 

Calibrate... 
Calibration should be performed the first time the scanner is used, and periodically, once every 4 - 6 
months. Click on this button to begin calibration. 
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Getting Started 

Scanning Business Cards 

The BizCardReader scanner is a portable high-resolution card scanner. After installing the scanner and 
application software, you are ready to begin scanning. 

1. Startup BizCardReader. 

2. Check that the Auto-Start scan feature is enabled (see Scanner Settings for details).  

3. Place the card or photo face down on the scanner. Gently slide the card forward into the scanning 
slot. 

4. The scanner will automatically start scanning and the card will be pulled through the scanner. 

5. Insert the next card when prompted, until all cards or photos have been scanned. 

When you have finished scanning the cards, a Progress Window showing the status is displayed.  After 
the image files are processed, the last processed record is displayed in the address book.  
 

If the orientation of any card is not upright, the Auto Orientation feature will usually detect the correct 
orientation and rotate the image to the upright position.  In the event that this feature does not correctly 
detect the orientation, you do not need to rescan the cards; you can use the Rotate facility in the main 
menu to correct the orientation.  
 

The system will automatically place the card information into their respective record fields. Sometimes, 

there is information on a card that the system cannot classify. This is placed into the Notes field.  

Scanning double-sided cards 

To scan a double sided card, place a check in the “Double Side” option in the main menu display. Then 
place the first side of the card on the scanner to begin scanning. The system will prompt you to insert the 
second side when ready. 
 
You can control the way the front and back of the cards are tiled from the options in Scanner Settings.  

Attaching Images  

BizCardReader allows you to attach multiple images (up to 8) to a single record. This feature is useful for 
storing additional cards or photographs associated with a contact record. 
 
To attach images to a record: 
1. Select and display the record. 
2. Click the Attach Image icon, or select Image... Attach Image option.  
3. Specify the scanning options in the Attach Image dialog box. 
4. Place the image to be scanned onto the scanner and then click OK.  
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Transferring data 

BizCardReader has extensive features which enable you to easily transfer all the text information from its 
database to applications such as spreadsheets, contact managers and handheld devices. 

Transfer data to Microsoft Outlook 

The simplest way to transfer data to Microsoft Outlook is to use the built-in synchronization feature. To 
synchronize data with Outlook: 
 
1. Outlook should be installed on your system. 
2. Start up BizCardReader and click on File... Sync Data... Setup. 
3. Select Outlook as the destination application and click OK. 
4. In the Transfer/Synchronization dialog box, click on the Outlook tab. 
5. Select the destination folder. 
6. Specify the records to transfer – all or current only. 
7. Specify/change the synchronization options (see bleow) if needed. Then click OK. 
8. To start synchronization, select File... Synchronize data... Go, or click on the Synchronize data icon. 

Outlook Sync Options 

The synchronization options control how data is transferred between BizCardReader and Outlook. To 
access the options,  
1. Start up BizCardReader and click on File... Synchronize Data... Setup.  
2. Select Outlook as the destination application and click OK 
 
The available options are categorized under the different group tabs. 

Outlook Tab 

Destination database folder 
Select or specify the name of the destination folder where the contact records are to be 
transferred. You can choose either the default contact folder or a sub-folder of the default contact 
folder. For Outlook 2000 and higher, you can choose the option ot select the folder at 
synchronization time. 
 

Records to synchronize 
All records in database - This will transfer all records in the currently opened BizCardReader 
database. 
Current record only - This will transfer only the record currently displayed in the BizCardReader 
application. 

 

Update Method Tab 
This option determines how duplicate records are updated. Duplicate records are records that have been 
transferred into Outlook during a previous synchronization action. When a duplicate record is encountered 
during synchronization, you can 
a. Skip it - do nothing and go on to the next record 
b. Overwrite the record in Outlook with the data from BizCardReader 
c. Overwrite the record in BizCardReader with the data from Outlook 
d. Overwrite either the BizCardReader or Outlook record with the record that was most recently changed. 
 
Note: Email, Memo and Notes fields are not updated in duplicate records. 
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Fields Tab 
Select the fields to be used for synchronization by clicking on the check boxes. 
 

Image Tab 
If desired, the image of the business card stored in BizCardReader can be transferred to Outlook and will 
be placed in the notes section. One of the following 2 methods of image transfer can be used. 

a. Linking the card image 
This method links the card image as an external file to the Outlook contact. The advantage in this is that the Outlook 
database is smaller because it does not contain the card image data. The disadvantage is that the image will no longer 
be available when you delete the BizCardReader database or the corresponding image in the BizCardReader database. 

b. Embedding the card image 
This method embeds the card image to the Outlook contact. The advantage in this is that the image is always available 
with the Outlook contact even when you delete the BizCardReader database. The disadvantage is that the Outlook 
database becomes larger with each embedded image.  

 

Category Tab 
The options in this group allows you to specify the categories for filing the contacts. 
 

Notification Tab 
These options determine the prompts and progress indicators to be displayed during the synchronization 
process. Select the options by checking the appropriate boxes. 
 

Transferring data to other applications 

You can use the Automatic Export or the Standard Import/Export features to transfer the card 
database to other applications. For more information, refer to the online help or see the section Exporting 
a Database. 
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The Main Window 

When you start the BizCardReader program, it displays the main window which contains the address 
book, icons and the main menu bar (at the top of the screen). This window contains most of the functions 
you will use for your card-scanning, photo scanning and card-retrieval tasks. 
 

 
 

 

 

Verified 
If this box is checked, it indicates that you have verified 
the currently displayed card information.  

 

 

 

 

 

Show Unverified Only 
If this box is checked, only “unverified” records will be 
displayed. It allows you to quickly find all records which 
have not been marked as verified. Click on this box to 
toggle the check mark. 

 

 

 

 

 

Search 
To search for a specific record, click in the Search input box 
with the left mouse. The list of available records appears in 
the window in tabular format. Enter the search string to find a 
record. 

 

 
 

 

Country of Origin 
Click on the down arrow to select the country of origin of the 
business card. Correct country selection ensures better 
accuracy and performance by the system when it reads and 
detects field entries such as Address, City, State and Code. 
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The Help/Status bar on the bottom of the display 
gives a brief description of the icon at the mouse 
pointer.  

 

 

 

 
 

Click to Drag cursor 
When you see the cursor message "Click to Drag", it means that 
you can move the indicated field contents by clicking on the 
mouse button and (without releasing the button) dragging the 
cursor to the destination field. 

 

 

Auto Indexing 
 

 
The letters below the address book indexes the records according to the selected sort field. Position the 
mouse pointer on any of the letter tabs and press the left mouse button. The first record in the database 
that begins with that letter will be displayed.  
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Control Menu and Image Icons 

Description of the Menu Icons 

 

 
 

Scan 

Start scan.  
Note: You do not need to use this 
button if the Auto-Scan feature is 
activated. 

 
 

Display Mode  
Switch between 3 display 
modes. 

 

 
 

Save Database 
Save the current database. 

 

Open Database 
Retrieve a saved database. 

 

 
 

New Record 
Create a new record by keying in 
data manually. 

 

Delete Record 
Delete the current record and 
its associated card image(s). 
 

 

 
 

Delete Image 
Delete the card image of the 
current record   

 

Attach Image 
Attach an image/photo to 
current record. 

 

 

Synchronize Data 
Synchronize data with other 
applications. 

 

Next Record 
View next record 

 

 

Previous Record 
View previous record. 

 

 
 

 

 

Expand Image 
Maximize the card image. 

 
 

Zoom Mode 
Zoom in/out of the image             
(use left/right mouse buttons). 

 

 
 

Draw Zone 
Mark a zone in the card image. 
The zone contents can then be 
dragged and placed into any 
record field. 
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Viewing Cards 

Display Mode 

The address book of BizCardReader is displayed in three modes.  Click on the Display Mode icon to view 
the different modes. 

You can also change the display mode by selecting Change Display under the Data menu, or by pressing 
F8 

Notes Field 

The Notes field contains miscellaneous information extracted from the card image. 

Viewing Records 

To move from one record to another use the Next and Previous icons. To move to the first or last record, 

select Edit from the main menu and choose Go Top or Go Bottom respectively. If the record number of 

the desired card is known, select Goto from Edit menu and input this number. 
 
 

Viewing Records in Tabular Format 

 

To view the card database in column format, simply point the mouse within the Search input box and click 
once on the left mouse button. The records will be displayed in tabular form in the View screen. To quit the 

View screen, press the Esc key or highlight a record and press the Return key. 

Verifying Card Information  

BizCardReader has a powerful proofing tool called the Card Verifier that enables you to easily proofread 
information in the scanned database. The verifier highlights the portion of the card image where the field 
information is extracted. It works in 3 modes: Normal, Cursor or Off. A tick beside a mode indicates the 

current mode. Choose the mode by selecting the Proofing option from the main menu. Choose a mode 
by clicking on it to select it. 

Normal Mode - The Verifier highlights the image section when you double click on the text data in a field.  

Cursor Mode - The Verifier automatically highlights the image section in any field where the cursor is 
placed. 

Off Mode - Disables the Verifier. 

Setting Zoom Percentage  
When using the Card Verifier, the line in the card image corresponding to the current highlighted word in a 

record field is displayed at the selected zoom magnification. The default is Zoom 100%.  To see the 
highlighted line in the card image displayed at a lesser magnification, choose a smaller zoom percentage 
in the Proofing Menu. 
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Zooming in & out of the image  

To zoom in closer to any portion of the displayed image, simply click on the Zoom icon  and then point 
and click on the image. To zoom out on the image, place the pointer on the image and click once on the 
right mouse button. 

Shifting the image Window 

In Zoom mode, you can shift the area of the card image displayed to any desired position. To do this, 
place the pointer in the image window, click and hold down the left mouse button. Then move the pointer 
to the new position and release the mouse button. Notice that as you move the pointer, the cursor 

changes to the hand icon . 

Expanding the card image to full view 

You can expand the displayed and view it in the Windows default image viewer by clicking on the Expand 

Image icon . Close the image viewer when done. 

Printing the card image 

To print a copy of the displayed image, first expand it to full view by clicking on the Expand Image icon 

. Then use the print features of the Windows image viewer to print the displayed image.  

Rotating the Image 

If the scanned image of the business card or photo is not in the upright position, use the options in the 
Image menu to manipulate the image.  You can rotate it Left or Right 90 degrees, or Upside-down.  

Read Card Contents 

Selecting this option from the Image menu causes the system to read (OCR) the image of the currently 
displayed card. The contents of the current display will be overwritten. 

Searching and Sorting 

Searching for a card 

 
 

To search for a card, simply enter the search string in the Search input box. The default search fields are 
the Name and Company fields. You can search for data in any field by using the Search By... option in the 
Data menu. 
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By default, BizCardReader searches the database for cards that contain all the keywords in the search 
string. The search is not case-sensitive: BizCardReader will find a record with 'IBM' in a specified field 
regardless of the search string being 'ibm', 'Ibm', or 'ibM'. The  search results are shown in a tabular form 
on the View screen. 
 
To view a specific record in the View screen, simply double-click on the desired record. Alternatively, use 

PageUp or PageDown keys to scroll up or down the list. Press Enter to view the currently highlighted 

record in the table. Press ESC to exit the search display. 
 

Using AND / OR Search Operators 

You can have greater control over the search process by using the AND (&& ) OR ( || ) search operators 
between keywords to govern the way the system searches for cards in the database. 
 

The system will search the database in all the selected search fields for the keywords specified in the 
Search For box. If multiple keywords and operators are used in a search string, the keywords will be 
processed in order from left to right. 
 

Example 
As an example, assume that your database contains the following 3 records. 
 
1. John Smith of Vision Corp 
2. Sue Marston of Alpha Tech 
3. James Smith of Alpha Inc 
 

The search fields selected are Name and Company.  

 

Type in the indicated keywords in the Search box and you will obtain the following results. 

 

Search   Result  Comment 

Smith   1, 3 

Smith && Alpha  3  AND operator 

Smith || Alpha  1,2,3  OR operator 

Smith Alpha  3  space defaults to AND 

John && Alpha || Smith 1,3  left to right order 

  

Sorting  

You can sort data on any of the available fields using the Sort By... option under the Data menu. If the 
option to Sort by Order of Record Entry is checked, the system will sort the records in the order the 
records were entered into the database. This is similar to sorting the records by the Date field. 
 

Editing Records 

You can edit any of the record fields in BizCardReader just like you would in a normal word-processor.  
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Editing Text 

To insert text, click on any of the record fields and type in the information you want to add. 
 

To copy text, simply highlight the text and click on Edit menu, copy option (Ctrl-C). 
 

To paste text, position the cursor at the insertion point. Select Edit menu, paste option (Ctrl-V). 
 

To move text, simply highlight the text and click on Edit menu, cut option (Ctrl-X). Then paste the 
information to the destination field. 
 

To delete text, simply highlight the text and use the delete or backspace key. 
 

To delete a card image, click the Delete Image icon from the menu box in the main window. Images 
deleted cannot be recovered. 

Drag & Drop 

The drag-and-drop feature is a quick and intuitive way to edit information in the record fields. 
 

1. Highlight the text you want to move. (or point to the field name if you are moving all information in the 
record field) 

 

2. Drag the highlighted text by clicking and holding down the left mouse button. 
 

3. Move to the destination field and release the mouse button.  

Drag and Drop text from Image to Data Field 

BizCardReader allows you to mark a reading zone on a displayed image and drag it directly into a data 
field. The built in optical character recognition engine will process the marked image zone, read any text 
data within the zone, and place the data in the designated field.  
 

1. Click on the Draw Zone icon  and mark a rectangular boxed zone in the image for reading by 
clicking and dragging on the left mouse button. 

 

2. Point within the boxed region, click and hold down the left mouse button, and drag the cursor to a 
destination field. 

 

3. Release the mouse button and the data will be read and placed into the destination field. 

Managing Databases 

Database Files and Image Files 

All text information for a given database is stored in a single database file with the file extension “.biz”.  

Additional miscellaneous information for the database is stored in the file with the extension “.dat”. The 
images associated with the database are stored in the same directory as separate image files (with the 
extension “.tif”, “.bmp”, or “jpg”).  The name of each image file is prefixed with the name of the database 
file. 
For example, if you have a database called MYDAT, then all image files associated with MYDAT have the 
following form: MYDAT00001.jpg, MYDAT00002.jpg, MYDAT00003.jpg. 
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Opening A Database 

1. Select Open from the File Menu or click the Open Database icon.  The Open dialog box will appear. 
 

2. Select a database to open and click OK.  The database will be opened and the first record is 
displayed.  BizCardReader permits only one opened database at any time. 

Saving A Database 

When a database is first created, it is given the name Untitled. To save the current database: 
 

1. Select Save... from the File Menu or click on the Save Database icon. 
 

2. Type a name for the database and select the directory to save it to and click OK. 

Copying A Database 

When you want to duplicate the current database for reason such as to backup the database, simply 
follow these steps:  
 

1. Select Save As... from the File Menu. 
 

2. Enter the file name and select the drive and folder you want this database to be saved under.  
 

3. If you want to include the images in the saving process, click on the Include Images checkbox. 
 

Merging Databases 

BizCardReader has the capability to merge databases. The current database can be expanded by 
importing records from another database.  

 

Before merging databases, make sure that the Maximum Records value in the System Setting is set to a 
number greater than or equal to the sum of the records in the two databases to be merged. To merge two 
databases, follow these steps:  

 

1. Click on the Open Database icon to open a database to which you want to add the additional records 

2. From the File Menu, Select Merge database... 

3. In the File Name box, enter the drive and the file name of the database you want to merge with the 

currently opened database. Click OK. 

4. In the Merge database dialog box, check the Include Image(s) box if you want to include the image(s) 
during the merging process. 

5. Select the desired radio button to specify how the system should handle duplicate records. 

6. Click OK to start the merging process. 

Deleting a Database 

You can delete a database if you no longer want to keep it in the system. 

1. Select Delete from the File Menu in the main window. The Delete Database dialog box appears.  

2. Select the name of the database that you wish to delete from the list box.  
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3. Click OK and the database will be deleted from the hard disk. All Database data and images will be 
deleted. 

Editing Field Names 

The names of the fields in the database can be changed according to the user needs. For example, the 
“User1” field name can be changed to “WorkCell”. To change a field name, click on the menu item Data… 
Edit Field Names. A dialog box with the editable field names will be displayed. The maximum length of a 
field name is 8 characters. Make the desired changes to the names, and click OK to save. 

 

The Automatic Field Content (AFC) is an optional data string you can specify for each of the editable 
fields. When a new record is created, the (empty) field will be automatically filled with the AFC data, if 
available. However, if the field already contains data (extracted from OCR reading of the card image), the 
AFC data will not be placed into the field. 

Copy Field Contents 

Copy Field Contents allows you to copy or move information from one field to another for all records in the 
database. 

1. Select Copy Field Contents... from the Edit menu  

2. Select the Source Field and the Target Field. 

3. Select to Append or Overwrite information in the Target Field. 

4. Check the Delete contents in Source Field after operation box if you no longer need the information in 
the Source Field after transferring the data. 

Updating a Database 

When new records are added or the Name fields of existing records are edited, the database may not 
remain in the correct sorted order. The AutoIndex keys may also become dimmed. In this case, use the 
Update option in the Data Menu to re-sort the database.  
 
 

Exporting a Database 

Export Methods 

BizCardReader provides several export features which enable you to easily transfer all the text information 
from its database to applications such as spreadsheets, contact managers and handheld devices.  

 Automatic Export - Transfers all the information in the database to a target application, automatically, 
whenever you update the database. 

 Standard Export - Transfers all or selected portions of the database, and creates new customized 
export formats. 

 Print to File – Writes out database information to a text file file.  
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Automatic Export 
 

The Automatic Export feature allows you to transfer all the text information in the database to an export file 
in a format which is compatible with the selected target application. Each time the database is edited and 
the contents saved, the export file is automatically updated. This frees you from the tedium of having to 
manually export the database whenever you scan new cards into the database or update the database 
contents. 

To set up the automatic export feature, do the following. 

1. Startup BizCardReader. Select Open from the File Menu to open a database containing the 
information you want to export.  

2. Select Import/Export from the File Menu and then select Auto Export from the sub-menu. The 
Automatic Export dialog box appears. 

3. Select the (target) application format by clicking on the down arrow of the Application list box. If the 
application is not listed, you should select and use one of the Standard Application formats. 

4. After you have selected the compatible application format, the lower edit box will display the name of 
the export file to which the database contents will be saved. The name of the export file will be the 
name of the database followed by the “.csv” or “.txt” extension. 

5. Note the name of the export file. Then click OK to confirm your selection or Cancel to quit. 

 

Note: After you have selected the target application and clicked OK, the system will automatically save or 
update the database contents to the export file whenever the current database is edited and saved. When 
you close the current database and open another database, the Automatic Export feature remains in 
effect and will save the newly opened database to a new export file as specified in step (4) above. 

To disable the automatic export feature, select “NONE” in the Application list box of the Automatic Export 
dialog box. 

To read in the database into the target application, startup the application and use its import utility to read 
in the export file obtained in step (4).  

 

Standard Text Export Format 
 

The Standard Text formats are export formats provided by the system to assist you in transferring the 
database information to third party applications. If the application to which you want to transfer data is not 
shown in the “Application format” list box, then select one of the Standard Text formats which is 
compatible with your application. 
 

The Standard Text formats essentially export data from ALL the fields in the database. The difference 
between the format types is only in the way the Address, Notes and Memo fields are exported. Some 
applications accept only one address line, while others may accept 2 or 3 line addresses. Similarly, some 
applications can accept separate Notes and Memo fields, while others require the Notes and Memo field 
information to be combined into one single field. 
 

The following chart summarizes the differences between the different Standard Application formats. 
 

Name  Address field  Notes and Memo fields 
Type A  Output in 1 line  Both fields combined into Notes 
Type B  Output in 2 lines  Both fields combined into Notes 
Type C  Output in 3 lines  Both fields combined into Notes 
Type D  Output in 1 line  Separate fields 
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Type E  Output in 2 lines  Separate fields 
Type F  Output in 3 lines  Separate fields 

 

Examples:  
The fields for Standard Text (Type A) format are as follows: 
 

1.    First Name 
2.    Last Name 
3.    Title 
4.    Company Name 
5.    Address (all 3 Lines) 
6.    City 
7.    State 
8.    Code 
9.    Country 
10.   Phone 
11.   Fax 
12.   E-mail 
13.  Web 
14.  Mobile 
15.  LastName 
16.  Date 
17.  User1 
18.  User2 
19.  User3 
20.  User4 

21.  Notes + Memo 

 

 
The fields for Standard Text (Type F) format are as follows: 
 

1.    First Name 
2.    Last Name 
3.    Title 
4.    Company Name 
5.    Address Line 1 
6.    Address Line 2 
7.    Address Line 3 
8.    City 
9.    State 
10.  Code 
11.  Country 
12.  Phone 
13.  Fax 
14.  E-mail 
15.  Web 
16.  Mobile 
17.  LastName 
18.  Date 
19.  User1 
20.  User2 
21.  User3 
22.  User4 

23.  Notes 

24.  Memo 
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Text and Image Export Formats 

The Text and Image formats are export formats provided by the system to assist you in transferring the 
database information to third party applications. 
 
The Text and Images (A - F) formats are basically the same as the Standard Text (A - F) formats, except 
that they include the image file names associated with each record. Eight fields (corresponding to the 
eight image file names) are appended to the end of each record in the exported file. 
 

Example: 

The fields for Text and Image (Type A) format are as follows: 
 

1.    First Name 
2.    Last Name 
3.    Title 
4.    Company Name 
5.    Address (all 3 Lines) 
6.    City 
7.    State 
8.    Code 
9.    Country 
10.   Phone 
11.   Fax 
12.   E-mail 
13.  Web 
14.  Mobile 
15.  LastName 
16.  Date 
17.  User1 
18.  User2 
19.  User3 
20.  User4 

21.  Notes + Memo 

22. Image 1 file name 

23. Image 2 file name 

24. Image 3 file name 

25. Image 4 file name 

26. Image 5 file name 

27. Image 6 file name 

28. Image 7 file name 

29. Image 8 file name 

 

Note: Unused image file names will be blank. For exampe, if a record has only one image file, then the 

remainder 7 unused image file names will be blank. 

 

Export Card Images 

You can export (i.e save) the images in the database to any folder on the hard disk. Each image 

associated with a record is saved to a file using the Name of the record as the file name. 
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For example, if the database contains a record John Smith with an associated image, then the exported 

image from the record will be the image file “John_Smith.jpg”, which will be saved to the folder specified. 

 

To Export Images: 

 

1. Select File… Import/Export… Export Images  

2. Select the target folder to which the exported images will be saved. We highly recommend that 

you pick a new/empty folder to contain the exported images. To do this, you will have to first 

create the target folder from your desktop application. 

3. Select the export range of records for which you want to save the images.  

4. Select the format of the output image file – e.g. by Name field (“John_Smith.jpg”) or Lastname 

field (“Smith_John.jpg”). 

5. Check “Append Record ID…” to append a the unique Record ID to the end of the filename (e.g 

“John_Smith_R12345.jpg”). This is useful if you have multiple records with identical names as it 

creates unique filenames for each record. 

6. Check “Append Picture Number…” to append a picture number “P1” to the first image filename of 

a record (e.g John_Smith_P1.jpg). If a record has multiple attached images, each additional 

image after the first will automatically have P2, P3… etc appended to the image filename.  

7. Check “Overwrite…” to allow overwriting of exiting images of the same name (if any) in the target 

folder. 

8. Click OK to export the images. 

 
 

Printing  

Printing Labels 
BizCardReader can generate mailing labels for all or selected contacts in the database. To print labels: 

1. Select Print from the File Menu, and then select Print Label from the sub-menu. The Print Label dialog 
box appears.  

2. Select the Print Range and Print Label options. 

3. Click the Labels button to select the type of label you want to print. The Select Label dialog box 
appears. 

4. Listed in the Labels list box are standard label types. To choose one of them, click on the desired 
label type and then click OK to return to the Print Label dialog box. If the desired label type is not 
listed, you can create a new label format by clicking on the New button. Refer to the section below on 
Label Layout for information on how to specify the label layout. 

5. Click the Fields button to select the fields that you wish to print.  Click OK when done. 

6. In the Print Label dialog box, select your desired font type by clicking on Fonts button.  Click on Setup 
button to setup the printer. 

7. Click Preview from the Print Label dialog box to view the layout of the labels in a page.  

8. If the layout is OK, click on Print button to start printing.  
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Label Layout 

The following gives an example of defining the label layout. 
 

 

Number of Label Rows:       4        

Number of Label Columns:  2 

w  - Label Width 

h   - Label  Height 

d1 - Vertical label distance 

d2 - Horizontal label distance 

x   - Top left label from left edge 

y   - Top left label from top edge 
 

 
 

Print to File 

The Print-to-File option allows you to write database information to a text file file. Writing to a text file is 
useful if you need to transfer the database information to a word processor for manual editing and 
formatting prior to printing.  
 
1. Select Print from the File Menu, and then select Print to File from the sub-menu. The Print To File 

dialog box appears. 

2. In the Print Range, select to save Current Record, Selected Records, Search Result or Full Database. 

3. In the Format pull down menu, click the down arrow and select the application you want to print to. 

4. Specify the filename and directory to save the output file and click OK. 

 

Frequently Asked Questions  

How do I back up the card database? 

We strongly reccommend that you back up the card database to avoid losing the data in the event of a 
system or hard disk failure. BizCardReader provides a simple feature for you to make a backup of all the 
data in the database. 
 
To create a backup of the database MyCardData: 
 
METHOD 1 

1. Start up BizCardReader and open the database MyCardData. 
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2. Click on the File menu and select Save As... 
3. In the Save As dialog box, select the folder where you want to store the backup database, and 

specify the name of the backup database (e.g. "MyCardDataBakup"). 
4. If you want to include the card images in the back up, place a check in  the Include Images check 

box. 
5. Click OK, and the database will be saved to MyCardDataBakup. 
6. Close MyCardDataBakup, and re-open MyCardData to continue your work. 
 
In the event that you need to recover the database, simply open MyCardDataBakup, and use the Save 
As feature to restore the database to its original location. 

 
METHOD 2 
You can use Windows Explorer to backup a database. In Explorer, simply make a copy of the folder 
containing the database MyCardData. In the event that you need to recover the database, simply restore 
the contents of the folder to its original location. 

How do I recover from a corrupted database? 

A hard disk or power failure may cause the card database to be corrupted. BizCardReader always keeps 
a backup of the last database that was saved. In the event that a database becomes corrupted, you can 
try to manually recover the last saved database following the procedure below. 
 
Assume that the corrupted database is named "MyCardData". To recover the database: 

1. Close BizCardReader, and start up Windows Explorer. 
2. In Explorer, open the folder where MyCardData is stored, and find the two files "MyCardData.biz", 

and "MyCardData.bak" 
3. Rename "MyCardData.biz" to "MyCardDataCorrupt.biz". 
4. Rename "MyCardData.bak" to "MyCardData.biz". 
5. Start up BizCardReader and open the database "MyCardData". If the last backup database is 

intact, you should be able to view all the records of the previous saved data before the database 
was corrupted 

How do I make a copy of my database? 

To create a duplicate of the current database, simply follow these steps:  
 

1. Select Save As from the File Menu. 
2. Enter the file name and select the drive and folder you want this database to be saved in.  
3. If you want to include the images in the duplicate database, check the Include Images checkbox. 
4. Click OK to start the copy process. 

Do I have to select the country of origin? 

The Country list box is located at the lower left region of the main display of BizCardReader. Selecting the 
correct “country of origin” of the business card ensures better reading accuracy and performance by the 
system when it reads and detects field entries such as Address, City, State and Code. To select the 
country 
 

1. Position the left mouse button on the down arrow located to the right of the Country list box and 
press on it once. 
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2. Select the country of your choice and click on the left mouse button once. “South East Asia” 
option includes countries like Singapore, Malaysia, Hong Kong and Indonesia. If a country is not in 
the list, choose “[Other]”. 

 

How do I print the displayed card image? 

To print a card or photo image, first locate the record and display the image on the main display of 
BizCardReader. Then click on the (yellow) Expand/Print Image icon on the left side of the image display, 
or from the Image item in the menu bar. This will launch the operating system default viewer for the 
image. You can then print the image from the system viewer. Consult the system viewer help for additional 
instructions on printing 
 

How do I create a new label format for printing? 

To create a new label, follow the steps below.  
1. From the Print Label dialog box, click on the Labels button. 
2. Click the New button in the Select Label dialog box. The Create New Label dialog box will appear. 
3. Enter the label specifications and the label name. Refer to the Label Layout section in this guide for 

details on how to specify the label parameters. 
4. Click the Save button to save all changes, or Cancel button to quit without saving. 

 

After you save the label format, it will appear in the “Label” list under Select Label dialog box. 

Can I scan more than one image to a record? 

BizCardReader allows you to attach multiple images (up to 8) to a single record. This feature is useful for 
scanning multi-sided cards, or for storing additional cards or photographs which you want to associate 
with a contact record. 
 
To attach images to a record: 

1. Select and display the record. 
2. Click on the Attach Image icon, or select the Image... Attach Image menu item.  
3. Specify the scanning options in the Attach Image dialog box. 
4. Place the image to be scanned onto the scanner and then click OK. 

How do I delete multiple records from a database? 

To delete multiple records from the database: 
1. Switch to the View mode by clicking on Data… View, or by clicking in the Search box. 
2. In the View display, select the records to delete by checking the box next to it. 
3. Click on Edit… Delete Record to delete all the records which have been checked. 

 

How do I export the database to Excel? 

To export the database to Microsoft Excel, you should first export the database to a file using the standard 
export or automatic export methods. Use one of the Standard Text (with image) formats for the export.  
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This will create a "CSV" (comma separated values) export file which can be opened directly from Excel. 
 

How do I create a new file export format? 

If the application to which you want to transfer data is not listed in the application format list in the Export 
dialog box, you can create a customized export format for it. To create a new export format, do the 
following. 
 

1. Select Export under File Menu or click the Export icon from the menu box.   
2. Click on the Edit button and the Select Export Format dialog box will appear. 
3. Click the New button and the Create Export Format dialog box will appear. 
4. Type in a name for the new format which you are creating. 
5. Select the fields to be exported from the Available Fields list box by highlighting the item and then 

clicking on the Select button. Alternatively, you can double-click on the item and it will be 
displayed in the Exported Fields list box.  

6. Select the character to use as field delimiter by clicking on Tab or Comma in the Delimiter box. 
7. If you wish to include the names of the fields in the first record of the output file, click on the 

Include Header checkbox. 
8. If you want the names of the image files to be included in the export file, check the Include Image 

Files box. 
9. Click OK when you are done with your selection or Cancel to discard 

 

How do I export or print only selected records? 

First switch to the View screen to select the records by clicking in the Search box. After you have selected 
the records, click on File… Print (or Export) to print the selected records.  
 

How do I import an external database? 

BizCardReader's importing function allows you to import data from other applications by reading in tab or 
comma delimited text files generated by the applications.   
 

To import data from other applications, you need to first export the data from the source application to a 
file in comma or tab delimited format. Refer to the manuals of the application on how to do this. After you 
have exported the data, startup BizCardReader to import the data into its database. 
 

To import a delimited text file: 
 

1. Select Import from the File Menu. The Import dialog box will appear. 
2. Click the Browse button. Find the import file and click Open. 

3. Select the delimiter: comma or tab if you know the format of the import text files. The system will 
usually perform its own auto detection for the delimiters.  

4. The list of fields in the first line of the imported file will be placed in the Available Fields box. 
5. Match the items from the Available Fields list with the Target Fields... list by highlighting your 

selection from both lists and then clicking on the Select button. 
6. The matched items will appear in the Mappings list box. 
7. To delete an entry in the Mappings list box, simply highlight the item and click on the Remove 

button. 
8. Click OK to import the database or Cancel to quit. 
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How do I merge 2 databases into a single database? 

BizCardReader has the capability to merge databases. The current database can be expanded by 
bringing in records from another database.  
 

Before merging databases, make sure that the Maximum Records value in the System Setting is set to a 
number greater than or equal to the sum of the records in the two databases to be merged.  
To merge two databases, follow these steps:  
 

1. Click on Open Database icon to open a database which you want the additional records to be 
added. 

2. Select Merge database...  from the File Menu.  
3. In the File Name box, enter the drive and the file name of the database you want to merge with the 

currently opened database. Click OK. 
4. In the Merge database dialog box, check the Include Image(s) box if you want to include the 

image(s) during the merging process. 
5. Select the desired radio button to specify how the system should handle duplicate records. 
6. Click OK to start the merging process. 

 

How do I set the maximum number of records in a database? 

The following procedure describes how the maximum records for a database can be changed.  
 

As an example, assume that you initially set the Maximum Records value to 1000. After scanning 950 
cards, you decide to increase the maximum number of records to 2000. The following steps should be 
taken: 
 

1. Save and Close the current database.  
2. From the Settings Menu, select the System option. The System Setting dialog box will appear. 
3. Change the Maximum Records value to 2000 and click OK. 
4. Reopen the saved database file. The maximum records that can be accommodated is now 2000. 
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Scanner Maintenance 

The scanner requires no maintenance except for occasional cleaning. Dirt and other foreign particles from 
scanned cards and photographs may accumulate on the scanning glass and roller after an extended 
period of scanning. If there are noticeable dark lines in the scanned images, the scanner may need 
cleaning. 

DuplexScan 1200/1210 Series Cleaning Procedure 

 

 
Instructions: 

1. Lift up the top cover of the scanner. 

2. Remove the SINGLE screw as shown. Use a small Philips head screwdriver. DO NOT remove 

any other screw. 
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3. Carefully lift up the left end of the upper imaging sensor.  
4. Slide off the end retainer and remove the sensor from the right end pivot hole. DO NOT detach 

the white ribbon cable from the sensor.  
5. Turn the upper sensor so that the glass plate faces up. Then rest the sensor on the scanner. 
6. Wipe away dirt or other particles from the upper and lower glass plates and rubber rollers with a 

dry cotton cloth. Use a small amount of rubbing alcohol if needed. 

7. Carefully re-assemble the scanner. Do not use excessive force when tightening the screws. 
 

DuplexScan 1200/1210 Battery Replacement 

 
 
Instructions: 

1. Unplug all cables from the scanner. 
2. Turn the scanner upside down, and remove the screw from the battery cover a shown in Fig. 1. 

3. Lift off the cover as shown. 
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4. Remove the battery and unplug the battery terminal from the socket. You will have to hold the (red 

and black) wires firmly at the base of the terminal, and rock gently to pull the terminal off the 

socket. 

5. Place the new battery into the battery compartment, and plug the terminal securely into the 

socket. DO NOT use excessive force. Note the pins in the socket as the terminal can fit in only in 

one direction. 

6. Carefully replace the battery cover over the compartment. When the cover is closed, the battery 

must be positioned completely within the raised boundary edges of the cover. DO NOT use force 

to close the cover; re-adjust the battery position if needed to ensure that the cover closes easily. 

7. Secure the cover using the screw. Do not over-tighten the screw. 

8. Plug the scanner into the USB port of a computer, and power on the computer in order to charge 

the battery. The battery should be charged 4-6 hours before use. The low battery light will turn 

off when the battery is sufficiently charged. 

9. The old battery must be discarded properly and should not be placed in fire. 
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BizCardReader 901 Vertical Mount Setup 
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BizCardReader 901 Cleaning Procedure 

 

 
 
 

1. Turn the scanner over so that 
the bottom side faces up. 

 
2. Remove the 2 screws located on 
the bottom of the scanner as 
shown. Use a small Philips head 
screwdriver. 
 

3. Turn the scanner upright, and 
carefully pry open the top cover. Lift 
off the cover and place it next to the 
scanner base. 
 

DO NOT DETACH the sensor wire. 

4. Press down gently on the glass to 
swivel and expose the surface. Wipe 
away dirt or other particles from the 
glass surface and rubber roller with a 
dry cloth or cotton swap. Use a small 
amount of rubbing alcohol if needed.  
 
 
5. Carefully re-assemble the top cover 

and screws. Do not use excessive 

force when tightening the screws. 
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BizCardReader 900C Cleaning Procedure 

 

 
 
3. Turn the scanner over so that the bottom side faces up. 
4. Remove the 4 screws located on the bottom of the scanner as shown. Use a small flat head 

screwdriver. DO NOT remove any other screw. 
5. Turn the scanner upright and carefully lift off the top cover. 
6. Wipe away dirt or other particles from the glass plate and rubber roller with a dry cotton cloth. Use a 

small amount of rubbing alcohol if needed. 

7. Carefully re-assemble the top cover and screws. Do not use excessive force when tightening the 

screws. 
 
 

BizCardReader 600C Cleaning Procedure 

 
 

a. Turn the scanner over so that the bottom side faces up. 
b. Remove the screw located on the bottom-right of the scanner as shown. Use a small flat head 

screwdriver. DO NOT remove any other screw. 
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c. Turn the scanner upright and slide the top cover slightly to the right and lift up carefully. 
d. Remove the black rubber roller by lifting it up from the roller slots.  
e. Wipe away dirt or other particles from the glass plate and rubber roller with a dry cotton cloth. Use 

a small amount of rubbing alcohol if needed. 

f. Replace the roller and carefully re-assemble the cover and screw. Do not use excessive force 

when tightening the screw. 
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Scanner Warranty and Notices 

Limited Warranty 

CardReader, Inc. (“Manufacturer”) grants a limited one year warranty for the BizCardReader 901/1200/1210 card scanner 
(“Scanner”), effective from the date of purchase. If the scanner is a free replacement unit for a faulty (original) unit covered by 
warranty, the warranty period of the replacement unit expires at the end of the warranty period of the original unit. The Scanner is 
only covered by the terms of the warranty if it has been handled properly in normal use and used only for the purposes for which it 
has been designed. 
 
If the Scanner is found to be defective in any way during its warranty period, Manufacturer will either repair or replace the defective 
Scanner with a new or refurbished unit; the course of action (repair or replacement) to be taken being determined by the 
Manufacturer alone. This warranty does not cover damage to the Scanner, resulting from accident, disasters, misuse, abuse, or 
any unauthorized modification of the Scanner. Limited warranty service may be obtained by delivering the defective Scanner to the 
Manufacturer within the effective warranty period, together with its original proof-of-purchase. 
 
Each warranty is effective only for the duration of its warranty period, and no warranty will apply after the end of its warranty period. 
After the expiration of the warranty period, the cost of repairing and/or replacing Scanner will be borne by the user. 
 
THE ABOVE WARRANTIES ARE EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES, EXPRESSED OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE AND NONINFRINGEMENT. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY MANUFACTURER, OR 
ITS EMPLOYEES, DISTRIBUTORS, AGENTS, OR DEALERS SHALL INCREASE THE SCOPE OF THE ABOVE WARRANTIES 
OR CREATE ANY NEW WARRANTIES. 
 
THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY HAVE OTHER LEGAL RIGHTS THAT MAY VARY 
FROM STATE TO STATE. 
 

LIMITATION OF LIABILITY 
MANUFACTURER SHALL NOT BE LIABLE FOR ANY DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION TO, 
DAMAGES FOR LOSS OF PROFITS, BUSINESS INTERRUPTION, LOSS OF INFORMATION, OR OTHER PECUNIARY LOSS) 
ARISING OUT OF THE USE OR INABILITY TO USE THE SCANNER. IN NO EVENT SHALL MANUFACTURER’S LIABILITY 
FOR DAMAGES RELATED TO THE INSTALLATION OR USE OF THE SCANNER EXCEED THE AMOUNT YOU PAID FOR THE 
SCANNER. 
 
SOME JURISDICTIONS DO NOT ALLOW EXCLUDING OR LIMITING IMPLIED WARRANTIES OR LIMITING LIABILITY FOR 
INCIDENTAL OR CONSEQUENTIAL DAMAGES, AND SOME JURISDICTIONS HAVE SPECIAL STATUTORY CONSUMER 
PROVISIONS WHICH MAY SUPERSEDE THIS LIMITATION. AS A RESULT, THIS LIMITATION OF LIABILITY MAY NOT APPLY 
TO YOU IF PROHIBITED BY THE LAWS OF YOUR JURISDICTION. 
 

FCC Statement 

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC 
Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This 
equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not 
occur in any particular installation. 
 
If this equipment does cause harmful interference to radio or even television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures: 
 

 Reorient the receiving antenna. 

 Increase the separation between the equipment and the receiver. 

 Connect the scanning and computer equipment into an outlet on a circuit different from   that which the receiver is 
connected. 

 Consult the dealer or an experienced radio / TV technician for help. 
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Declaration of Conformity 

DECLARATION OF CONFORMITY 
According to 47CFR, Part 2 and 15 for: 

Class B Personal Computers and Peripherals; and/or 
CPU Boards and Power Supplies used with Class B 

Personal Computers: 
 
We: CardReader, Inc. 
Located at: 1411 Ramon Dr.  
 Sunnyvale, CA 94087 
 Telephone: (408) 733 2233 
Declare under sole responsibility that the product identified herein, complied with 47CFR Part 2 and 15 of the FCC rules as a Class 
B digital device. Each product marketed is identical to the representative unit tested and found to be compliant with the standards. 
Records maintained continue to reflect the equipment being produced can be expected to be within the variation accepted, due to 
quantity production and testing on a statistical basis as required by 47CFR 2.909. Operation is subject to the following two 
conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including 
interference that may cause undesired operation. 
 
Trade Name: BizCardReader / DuplexScan 1200, 1210 
Type of Product: Card Scanner 
Models: USB201 / USB203 / BCR300 / BCR900 / BizCardReader 1200DX, 1210DX 
 


